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U svom treéem nastavku
primena Power Point 2003
u nastovi autor iscrpno pre-
zentira brojne detalje onih
mogucnosti koje u sebi
sadrii ovaj program.

Tu su instalacije proje-
ktovaonjo, animacije sa
brojnim mogudnostima i
usmerenjima, ratim Stelo-
vanje efekotn, skrivanje
ikone, fiksiranje pratedih
tekstova i dr.

Prezentacija za pokreine
slike so detaljima moie
mnogo pomodi operati-
vnom korisniku do obogaoti
prezentacdiju i véini je dina-
miénom.

Tu treba istud nastojanje
autora da na razumljiv
nafin prezentira nafin vve-
canja sadrioja na ekranu
time se duje posebna upe-
dotljivost posmatrafimo.

Hivatdsunk eszkdztdrdbdél

A PowerPoint 2003 alkalmazasa az oktatasban
II1. rész

MNamesztovszki Zsolt

VETITESI BEALLITASOK

A diavetités bedllitdsait a Diavetités menii
Vetitési bedllitdsok parancsdaval megjele-
nithetd parbeszéd panelen adjuk meg (Slide
Show > Set Up Show). Ez a parbeszéd panel
jelenik meg akkor is, ha a SHIFT billen-
tyli nyomva tartdsa kozben kattintunk a
Diavetités nézetvilaszté gombra. :

A Bemutatdéd tipusa (Show type) cso-
portban hiarom kiilénbézé wvetitési maod
kéziil valaszthatunk.

Alapesetben a Bemutatds &loszé
mellett (Presented by a speaker) opciot
haszndljuk, mely teljes képernyés weti-
tést tesz lehetdvé az altalunk megadott
iddzitésnek megfeleld lejatszdssal. A leg-
gyakrabban haszndlt vetitési madd, teljes
képernyds vetitést tesz lehetveé, egy
eléadd irdanyitdsa mellett. Ezt a méd-
szert haszndljuk ha a bemutatot na-
gyobb képernyfn szeretnénk kivetiteni,
eldad4sok, konferencidk alkkalmawal.

Az Iranyitott bemutaté (Browsed by
an individual) opcié vilasztasa esetén a
bemutatd egy ablakban keriil lejatszasra,
melyhez kialén eszkéztir és meniisor tar-
tozik (didk madsolasa, szerkesztése, nyom-
tatdsa). Ezt az opcidt eldadd nélkiili bemu-
tatd vetitésére haszndlhatjuk. Az elGadds
kozonsége maga vezérelheti a bemutatét,
amelyhez gorditGsavot is megjelenithetiink
(Show scrollbar). Ezt a modszert akkor
haszndljuk, ha a bemutatonkat kisebb
képernydn futtatjuk (halézaton, fel-
haszndlok sajat képernyédjiikén tekintik meg

a felhasznalok). A gorditGsdv segitségével
tudunk haladni diarol-didra, és egyidejiileg
masik programot is nyitva tarthatunk.

A Kirakati bemutaté (Browsed at a
kiosk) opcioval a bemutaté egy dndlléan
futd, dllanddan ismétlédd bemutatoként
keriil lejatszdsra. Akkor célszerid hasznal-
ni, ha a szamitdgépet egy kirakatban vagy
elirusitéhelven feliigyelet nélkiil hagyjuk.

A Kockik (Show slides) csoport-
ban meghatirozhatjuk, mely képkockak
keriiljenek lejatszasra. Ezt a részt akkor
haszndlhatjuk, ha a prezenticio egy részét
szeretnénk csak bemutatni. Be tudjuk
adllitani az elsd (From) és az utolsé (To)
kivetitésre keriild diat. A Minden kocka
(All) beallitasnal az 6sszes dia bermutatas-
ra keriil.

A didk egyéni sorrendben torténd
lejatszdsahoz a kivant sorrendet a
Diavetités menii Egyéni diasorok pa-
rancsdval dllithatjuk &ssze (Slide Show >
Custom Shows).

A Tovabbitias (Advance slides) cso-
portban bedllithatjuk, hogy a képkocka-
kat a vetités soran sajat keziileg tovibit-
suk (Manually) vagy az el6re megadoit
idézités alapjin automatikusan jatszédja-
nak le (Using timings, if present).

Az Ismétlés az ESC lenyom:isdig
(Loop continuously until “Esc') jelola-
négyzet bekapcsoldsaval a bemutatd auto-
matikusan addig ismétlédik, amig az ESC
billentytivel a vetitést meg nem szakitjulk
Ez az opcid kirakati bemutatd vdlasztisa
esetén kotelezden bekapcsoladik.
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A Kisérdszoveg nélkiil (Showwithout
narration) jeltlénégyzet bedllitdsaval
a bemutatd kisérésziveg nélkill fut le
{amelyet esetleg eldbb rogzitettiink).

Az Animdcié nélkiil (Show without
animation) jelélénégyzet bekapesolasa
esetén a diakon beallitott animacidk nem
keriilnek lejitszdsra, az egyes didk tugy
jelennek meg, mintha az animaciok le-
jatszdsra keriiltek volna.

Ha a Bemutaté €ldszé mellett op-
cidt wvdlasztottuk, a bemutatd sordn
lehetdségiink van a didkra rajzolni. A Tin-
taszin (Pen color) legordild lista segit-
ségével az ehhez hasznalt tinta szinét
allithatjuk be.

A Megjelenitd eszkiiz (Display slide
show on) legordiilé listdban egy maso-
dik monitor bedllitdsdra is lehetéségiink
van. [gy az egyik monitoron az eléadé az

eladashoz tartozo segitdé informacidkat (a

jegvzeteket, az eléadas didinak kicsinyi-

tett képét) lithat, mig a masodik moni-
toron teljes képernyén vetiti a bemutatot.
Ennek a lehetdségnek a haszndlatihoz
Windows 98 vagy tijjabb Windows oper4-
cids rendszerre, és a két monitor hasz-
nélatdt lehet&vé tevd hardverre van sziik-

ség (laptop képernydje + projektor).
FELADATOK

1. Prébaljuk ki a hdrom killonb&z6 vetitési
madot, figyeljitk meg a kiillonbségeket a
vetités kazben!

2. A tintaszin kivdlasztdsa utdn rajzoljunk
a didra vetités kszben!

3. Jelenitsiik meg a bemutatd egy megha-
tdrozott részét (példiul 4-6 dia)!

21. kép. A vetitési bedllitdsokat tartalmazé panel




Ndmesztovszki Zsolt

Attiinések bedllitdasa

Eléadasunkat latvanyosabba tehet-
juk a didkon megjelend feliratok, képek
animalasdval, kiilénféle attéinési hatidsok
beallitisdaval. A megfeleléen alkalmazott
animiécidok wvagy attlinések nemcsak ér-
dekesebbé tehetik eldadasunkat, de se-
githetnek mondandénk f6bb részeinek
kiemelésében is.

Az attiinés a diavaltds sordn az egyvik
diaképbdl a masik diaképbe valé dtmenet.

Az Attlinés munkaablak a Diavetités
menii Attlinés parancsdaval (Slide Show
> Slide Transition) vagy a munkaab-
lak lenyilé meniijének segitségével jele-
nithetd meg. A kijelolt diadk megjelené-
sekor alkalmazanddé hatdst az eﬁttﬁnés
(Slide Transition) munkaablakban, az
Alkalmazas a Kijelilt didkra (Apply to
selected slide) listaban valaszthatjuk ki.

Az dttdnés sebességét a Sebesség
(Speed) listéban a Lassu, Kozepes vagy
Gyors (Slow, Medium, Fast) opciok va-
lamelyikének kivilasztdsdval szabalyoz-
hatjuk. A Hang (Sound) listdban az atti-
néskor megszolalé hangot rendelhetiink
a didhoz. Itt bedllithatjuk azt is, hogy a
hang folyamatosan ismétlédjon a kévet-
kezd hang (Loop until next sound) vagy
dia megjelenéséig.

A Tovabbitas (Advanceslide) csoport-
ban meghatirozhatjuk, hogy a képvdltas a
felhasznilo kezdeményezésére vagy auto-
matikusan torténjen. A Kattintdsra (On
mouse click) jelolénégyzet bekapcsolt
dllapotdban a felhaszndlé barmikor a k-
vetkezdé didra léphet. Az Automatikus
(Automatically after) jelslénégyzet be-
kapcsoliasa esetén a PowerPoint a meg-
adott idd elteltével automatikusan atvalt
a kévetkez6 didra.

Minden diavaltashoz eltérd atti-
nést adhatunk meg, de ha az egyik di-
dhoz bedllitott attilinést az &sszes tobbi
diaképvaltdsnal is alkalmazni szeret-
nénk, akkor kattintsunk az Alkalmazis
az Osszes didra (Apply to All Slides)
gombra. A bedllitott dttinési médot az
ikonra vagy a Lejatszds (Play) gombra
kattintva tekinthetjiik meg. A Betekintd
(AutoPreview) jelolonégyzet segitségé-
vel engedélyezziitk a kivalasztott attdinés
automatikus bemutatdsdt a Dia ablak-
tablan.

'éi‘.iktu“ e -; .'-x'.
Alkalmazas a kijelolt diakra:

Aiiesl be

Ealkrdl be

Ealrdl és Fentrdl be
Ealrdl és lentril be
Befelé siikivés =
Eloszlis
Elstibétibis

Enyhie halvamydas
Fellldl be 43
Fésil Fantrsl
Fésil oldalrél :‘ﬂ

’;c- TS & ket kars
hang Injaszacaly :
Tovebbitds L
F Kattrtdsra ity

22. kép. Attinések beallitisai
a munkaahbhlakban
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FELADATOK

1. Rendeljiink tetszdleges Attlinéseket az
elkészitett didkhoz!

2. Rendeljiink automatikus tovdbbitdst a
diankhoz (45 masodperc)!

Animalas
Animalasi sémak

Egy dian lévd sziveg alapesetben egy-
szerre jelenik meg. Gyakran azonban
arra van sziikségiink, hogy egy felsorolis
elemei csak egymads utdn jelenjenek meg.
Animacionak nevezziik a didk egyes
elemeinek lejitszds sordn térténd moz-
gatdsit, illetve fokozatos megjelenitését.
Ajanlatos kiprobdlni az animacidkat, hi-
szen az egyszerii betszastdl, a gépirdsos,
a bees6t, az elfordulo, a fényképezdgép-
szerti megjelenitéseken at, a legkiuilonfeé-
lébb speciialis megjelenitésig sokféle ani-
maciot valaszthatunk. Az animdciokat
hanghatasok is kisérhetik. A PowerPoint
messzemenden tdmogatja ezt a lehetdsé-
get, hiszen nemcsak animdlni tudjuk a
didkon talalhaté objektumainkat, hanem
idéziteni is.

A listdt legegyszertibben a Diavetités
menii Animdalasi sémak parancsdval
(Slide Show > Amnimatiomn Schemes)
jelenithetjiik meg. A munkaablak
Alkalmazas a kijelolt diakra (Apply to
selected slides) lista megfeleld elemére
klikkelve valasztjuk ki animdcids sémat.
Alkalmazas az Osszes diara (Apply to
All Slides) gombra kattintva a kivdlasz-
tott animdcidt a teljes eléaddsra is bedl-
lithatjuk.

o

23. kép. Animdcids sémak
a munkaablakban

Ha a munkaablak aljan lathatd
Betekintd (AutoPreview) jelolénégyzet
be van kapcsolva, a PowerPoint azonnal
megmutatja a kivdlasztott animaciét. A
didhoz rendelt animaciot késébb is meg-
tekinthetjiilk a dia kivdlasztasa utan a
Lejatszdas (Play) gombra kattintva. Az
animadcios he*4-t tartalmazd diakat a dia
alatt lathaté = ikon jel6li.

Az animdcié megsziintetéséhez ren-
deljitk a didhoz az Alkalmazds a kije-
161t didkra lista Nincs animdcié (No

Animation) elemét.

-

OE @ 53
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Egvéni animdcidk

A PowerPointban lehetdségiink wan
a didk egy-egy (vagy az 6sszes) eleméhez
a tobbitdl eltérd, testreszabott animacios
hatdst rendelni, illetve az elemek ani-
maldsdnak sorrendjét meghatdrozni. Ezt
nevezzilk egyéni animdciénak. Egyéni
animadciod bedllitdsira a Normal megjele-
nités nézetben van lehetdségiink.

Egy dia egy wvagy tébb kijelslt ele-
mehez (azok kijelclése utan) az Egyéni
animacié munkaablakban rendelhe-
tiink animdcids hatdst. Az Egyvéni ani-
mécié munkaablak megjelenitéséhez
kattintsunk a Diavetités menii vagy a
gyorsmenii Egyéni animidcid (Custom
Animation) parancsdra. Az elem meg-
jelenésekor alkalmazott animdacios hata-
sokat a Hatds hozzdaddsa (Add Effect)
gomb lenyiléd meniijébél valaszthatjuk
ki. A Megjelenés (Entrance), Kiemelés
(Emphasis) és Eltiinés (Exit) almenik
parancsai segitségével az elemek megjele-
nitéséhez, kiemeléséhez, illetve eltlinésé-

hez haszndlt effekktusokat dllithatunk be.
Az Utvonalak (Motion Paths) almenii
parancsai segitségével az objektumot egy
meghatarozott titvonalon mozgathatjulc
A Tovabbi effektusok (More Effects) pa-
rancs segitségével megjelenithetd parbe-
széd panelen tovabbi animdcids hatdsok
koziil vdlaszthatunk.

: 1. Bedsz&s
S 2 Kerst

: . 4. Reddry
B 5. Rombuse

24. kép. A hatdsok csoportositisa

Az animdcidckat még jovdhagyds elitt
megtekinthetjiik, ha bekapcsoljuk a Hatés
megtekintése (AutoPreview) jelolénégy-
zetet. A Hatds hozzdaddsa gomb segit-
ségével elérhetd hatisok egy része csak
meghatarozott objektumok esetén alkal-

Legismertchb szl ogép tipusols

rsmnrmitorep (nagy tel jrsitrmomy: Neca, melerologia])

Voerm e - seod

15 % Legismmertebb szdmi.. .
25 ¥ shepe i: Legsmes,.,
i tocie st S
33 W supsrszdmdGop (...
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mazhatd. Azon elemek mellett, amelyek-
hez animdcids hatdst rendeliink egy az
animdacio sorrendjét jelzé sorszdam jelenik
meg a didn. Az animalt elemek listdja a
munkaablakban is megjelenik. Egy-egy
objektumhoz tetszdleges szamil anima-
cios hatast rendelhetiink. Uj animadcios
hatds hozzdaddsihoz az objektumot min-
dig a didan kell kijeldlniink. Ezutin a mar
megismert modon vdlasszuk ki a meg-
feleléd hatdst a Hatds hozzdadasa gomb
segitségével (meghatdrozhatjuk a szdveg
megjelenési animacidjat, eltiinését sth.).

A munkaablakban megjelenik az ani-
mdcio fajtdja (a szovegmezd tartalma) és
az, hogy az animdcio milyen eseményre
indul el (egérkattintis, automatikus, id&-
zitett).

Az animdcid sorrendjének modosita-
sdhoz jeldljilk ki a munkaablakban lat-
hato lista megfelelé elemeét, majd kattint-
sunk a lista alatt taldlhaté Atrendezés
(Re-Order) gombok wvalamelyikére. Az
animdcid sorrendjét a Fogd és vidd maéd-
szerrel is modosithatjuk.

Egy animéciés hatds modositdsiahoz
jeléljiik ki azt a munkaablakban. Ekkor
a Hatds hozzdaddsa gomb Mdadositas
(Change) gombba viltozik. A Mddositas
gomb segitségével a kijelélt animadciot
masikra cserélhetjiik.

A munlaablakban, ha kijeloljiik az
animdciot, akkor a Modositds (Modify)
csoport wvalik liathatéova. A Modositas
csoportban a kivdlasztott objektumhoz
rendelt animacio kiilonféle, a lejatszdssal
kapcsolatos wviltoztatasokat eszkézodlhe-
tiink. Az Inditds (Start) mezbben a ko-
vetkezd vdlasztasi lehet6ségeink vannalk:
Kattintiasra indul (On Click): a kijelslt
animdcidé a wvetités soran egérkattintds

a listan eldtte alld objektum animdcio-
javal egyiddben indul el. Az eldtte lévd
utin indul (After Previous) meghata-
rozott idd utdn automatikusan, az eldt-
te lévd animicio lejatszdsa utdn indul.
Ebben a csoportban viltoztathatjuk meg
még a mozgatids Iranyat (Direction) és
Sebességét (Speed).

Indtés: [ Kattintdsra. @
'Iré_mi: ;  |Lentrdl Lg
Sebesséq: | Magyon gyors I‘@

26. kép. Az animalisra vonatkozo utasitasok
a munkaablakban

Az animdcios hatassal kapcsolatos to-
wvidbbi bedllitdsokat a gyorsmenii Effektus
bedllitasai (Effect Options) parancsa-
nak segitségével megjelenitheté panelen
adhatjuk meg (a panel elérhetd ugy is, ha
a munkaablakban az animdciora duplan
klikkeliink). A panel neve és tartalma a
kivialasztott animdcios hatdstal fiiggben
eltérd lehet.

A Bedllitasok (Settings) csoportban
a kivadlasztott animdcios hatdsra jellemzd
tulajdonsagokat dllithatunk be (animaci-
Snként mas).

A Hang (Sound) legordiils lista segit-
ségével tetszdleges hanghatést rendelhe-
tiink a kivadlasztott elemhez. A lista elején
taldlhatok a PowerPoint dltal felkinalt
lehetSségek (beépitett). Az utolsé me-
niipont az Egyéni hang (Other Sound)
segitségével a hattértirunkrél tudunk
hangot hozzdrendelni az animaciénk-
hoz (wav kiterjesztésiti fajlokat tudunk
haszndlni). A hangkiséret segithet mon-
danivaldjdnak kihangsulyozdsiban és a

P e
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macio lejatszdsa utdni eseményeket. Ezek
a beidllitdsok segithetnek az eldaddsunk
kovetésében (a tulhaladott mondatok
vagy pontok elhalvinyulhatnak vagy el-
tinhetnek) illetve a lényeg kiemelésé-
ben. Az alapbedllitis a Nincs halvanyitas
(Don’t Dim) opcité. Ennél a beéllitds-
nal az animacié lejatszasa utin a szdveg
megjelenitése nem valtozik. A felkinalt
vagy a Tovdbbi szinek kivialasztasaval
a szdveg animdldas utdni szineit tudjuk
meghatdrozni. Elrejtés animalas utan
(Hide After Animation) a program el-
rejti a szdveget a hozzd tartozé effektus
lejatszasat kovetSen. Elrejtés a kivetkezd
kattintdsra (Hide on Next Mouse Click)
opcidénal a program a kdvetkezd kattin-
tisndl rejti el az el6z6 objektumot.

A Szoveg animdldsa legordiild lista-
ban meghatarozhatjuk, hogy a feliratok
Egyszerre (All at once), Szavanként (By
word) vagy Betiinként (By letter) jelen-
jenek meg.

Az Idézités (Timing) fillnél meghata-
rozhatjuk az elem megjelenésének olyan
id6zitési paramétereit, mint az Inditds
(Start) modjit, a Késleltetés (Delay), a
megejelenitési Sebesség (Speed) és az
Ismétlés (Repeat) bedllitasait.

: A  Sziveg animdldsa (Text
Animation) fiilnek akkor van jelentdsé-
ge, ha tobb bekezdésbol dllé szovegrészt
kivinunk animalni.

Ha el szeretnénk tdavolitani a di-
4rol egy vagy tobb effektust, a munkaab-
lak listajaban jeldljik ki az eltdvolitando
effekktust, és kattintsunk az Eltdvolitds
(Remove) gombra.

Idézitésproba

Ha elére ki szeretnénk probalni, hogy
avetités didnként és Gsszesen mennyi idot
vesz igénybe, esetleg ehhez kivanjuk hoz-
zdigazitani a vetitési bedllitdsokat, akkor
haszndljuk ki az id6zitéspréba leheti-
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segeit a Diavetités menii Idézitéspréba
(Slide Show > Rehearse Timings) me-
niipontjaval. Ekkor a wvetités ugy indul
meg, hogy a képerny6n egy kis szamlilé
is latszik, amely az idémérésen kiviil a
valtasok rogzitésére is hasznalhatd.

Részletes

SN T AR

28. kép. Az iddzitéspréba vetitésénél
megjelend panel

FELADATOK

1. Készitsiink el egy felsorolds-
bol, képekbdl dllé diat, amelyen hasz-
naljuk a megjelenés, kiemelés, eltlinés,
halvinyitds és a hang (hozzirendelése
az animadldshoz) lehetéségeket! http://

www. magister. du.yu/powerpoint/ani-
malasl.ppt

Hangok &

A hangot fijlbol vagy a médiatarbol
masolhatjuk a didra. Ezt a Beszirds menii
Mozgoképek és hangok almeniijének a
Hang meédiatirbol (Sound from Clip
Organiser) vagy a Hang fdjlbél (Sound
from File). Hangot a Meédiatarbdl is
beszurhatunk.

A hang beszirdsa utian a PowerPoint
felkinalja a lehetéséget a hang automati-
kus lejatszdsdra.

29. kép. A hang besziirdsa utdin
megjelend kérdés
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A didra beszurt hangot ikon jeleni-
ti meg. Ez az ikon a didn a wetitéskor
is megjelenik. Az ikont a diin a Fogd
és vidd modszerrel tetszdlegesen dthe-
lyezhetjiik. A hang lejatszasit szerkesztés
kiézben az ikonra duplin kattintva, vagy
vetités kizben az ikonra egyszer kattint-
va indithatjuk el.

A hanglejitszas inditdsira vonatkozd
bedllitist barmikor megviltoztathatjuk
az Egyéni animdcié munkaablakban.
Jobb klikkelés utian (az animaciéra) va-
lasszuk a helyi menii Effektus bedllitdsai
(Effect Options]) meniipontot. Az ez-
utdn megjelend panelen a Hatds (Effect)
fillon meghatdrozhatjuk (moédosithatjuk)
a hang lejdtszasanak induldsat (az ele-
jétsl, idézitve) és a hang leallitisat (a
kovetkezd klikkelés, az aktuilis dia utdn,
megadott seami dia utan). (30. kép)

Egy madsik helyen tovabbi hangbedl-
litasokat adhatunk meg, példdul a hang
ismétlését vagy az ikon elrejtését. Ide a
hangikon helyi meniijéb&l juthatunk el
Kattintsunk jobb gombbal a hangikonra
a helyi menii megnyitisahoz, majd vd-
lasszuk a Hangobjektum szerkesziése
(Edit Sound Object) parancsot. A Hang
ismétlése (Loop until stopped) a hang-
leallitds modjatol fiiggden ezen beallitds
hatdsdara a program addig ismétli a han-
got, amig a felhasznald le nem dllitja azt.
Ha bejeloljitk a Leadllitdsig ismétli jels-
lénégyzetet, majd a hangledllitast hirom
diaval késébbre allitjuk, a hang ismétls-
dik a hdrom dia megjelenitése soran.

A Hangerd (Sound volume) gombra
klikkelve egy skala nyilik meg, ahol bedl-
lithatjuk a hangerét.

Ikon elrejtése (Hide sound icon
during slide show) a megfeleld jelolo-
négyzetet bejeldlve a program a hang-
ikont elrejti diavetités kézben. Ezt a lehe-
tBséget azonban csak akkor hasznaljuk,
ha a hanglejatszdst automatikusra alli-
tottuk, vagy valamely egyéb vezérlGele-
met (példdul akciogombot) hoztunk létre
a hang lejatszdasdhoz. Normdl nézetben
mindig lathatd a hangikon.

Az Informdcié (Information) te-
riileten lathaté a hangfijl helye. A
»Bemutatéban elhelyezve” (Contained
in presentation) szoveg azt jelenti, hogy
a fijl a bemutatd része, nem pedig mas-
honnan wvan csatolva. A 100 kilobajt-
nil (KB) nem nagyobb meéretid fdjlo-
kat alapértelmezés szerint bedgyazza a
program. Ekkor azok a PowerFPoint .ppt
fajlianak részét képezik, és azzal egyiitt
mozgathaték. A 100 KB-nil nagyobb
méretii fijlokat, illetve az OGsszes tabbi
tipusii hangfdjlt a program csatolja a
bemutatéhoz. E fajlok a .ppt fdjlon kiviili
helyrél jatszhatok le, és fizikailag nem
képezik a bemutaté részét. Ha tehdt a
bemutatét masik szdmitogépen szeret-
nénk futtatni, gondoskodnunk kell arrél,
hogy a csatolt hargfijlok ugyanabban
a mappaban legyenek, mint a futtatni
kivant bermutaté.

A bedgyazott .wav fajlok 100 KB-
os maximdlis mérete a Eszk6z6k menii |
Beallitdsok parbeszédpanelén talal-
hatd (Tools > Options). Az Altalanos
(General) lapon a maximdlis méretet
akar 50000 KB-ra is nivelheti, de ne
feledjiik, hogy a bedgyazott fijlok megnd-
velt mérete a teljes bemutatd nagysagara
is hatdssal van.




A PowerPoint 2003 alkalmazdsa az oktatdsban

Hanghbeallitase

31. kép. A Hangobjektum szerkesztése
parancs utin megjelend panel

Kisérdszoveg rogzitése

A bemutatdnkhoz sajat készitésii kisé-
részoveget tudunk késziteni a Diavetités
menit Kisérdszoveg rogzitése menii-
pontjira mutatva (Slide Show > Record
Narration). A kisérdsziiveg rogzitésé-
hez szitkségiink van egy csatlakoztatott
és megfeleléen bedllitott mikrofonra.
A klikkelés utin megjelend panelen be
tudjuk 4llitani a mikrofon hangerejét,
a rogzitett hang mindségét (a mindsé-
gesebb a hangok tébb helyet foglalnak

a hattértarunkon), meghatirozhatjuk a
kisér6szoveg elmentésének a helyét, il-
letve azt, hogy csatolja-e a kisérbszoveget
a PowerPoint a bemutatéhoz. Az OK
gomb lenyomdsa utdn a vetités indul. A
vetitéssel (animaciékkal) dsszhangban a
kisérdszoveget tudjuk réogziteni.

Az oktatasban a hagyomédnyos bemu-
tatdnkat tehetjitk szinesebbé, valamint a
nyelvordkon (kiejtés fontossdga) hasznil-
hatjuk a kisérészovegek rogzitését.

Zeneszamok beallitasa '@

Bemutatonk zenei alafestéséhez Au-
dio CD-n taldlhaté zeneszdmokat is hasz-
nilhatunk. Elészér helyezziik a meghaj-
téba a CD-t. Majd mutassunk a Beszaras
meniit Mozgoéképek és hangok pontjara,
majd klikkeljink a Hangos CD lejdit-
szdsa parancsira (Insert > Movies and
Sounds > Play Audio CD Track). A
hanganyagot a fenn ikon jeleniti meg a
didinkon. A Hangos CD elinduldsat és
leallitdsat a hangokndl leirt médon tud-
juk meghatédrozni. A Hangobjektumok
szerkesztésénél azonban egy maisik pa-
nellel taldlkozunk.

32. kép. A Kisérdsziveg riogzitése utasitis bedllitasai




Ndamesztovszki Zsolt

Zened T behelyerdse

33. kép. A hattérzene (Audio CD-rél)
bedllitdsai

Az itt megjelend ablakban tudjuk maé-
dositani az elsé és az utolsd lejatszdsra
keriilé zeneszamot és ezek terjedelmét.
Ezek a lehet&ségek féleg ondlléan futd
vetitésele esetében célszertiek. A CD-r6l
lejatszott héttérzene a bemutatéknak sa-
jatos hangulatot kélestindzhet. Eldnyiik,
hogy nem névelik a bemutaté méretét.
Ugyelni kell azonban, hogy a CD-t a be-
mutatdra magunklkal vigyiik, illetve arra,
hogy a meghajtéba helyezziik.

FELADATOK

1. Csatoljunk egy hangfajlt, amely 3 dia
utdn 4ll le!

2. Csatoljunk egy hangfdjlt, amely folya-
matosan ismétlédik!

3. Hatdrozzuk meg, hogy a beszurt hang-
fijl a 3. masodperctél induljon!

Mozgdképek

A mozgoképek mondanivalénk szé-
mos pontjat alatdamaszthatjik a bemutatd
alatt. Szdmos folyamat, esemény szemlél-
tetése sokkal hatdsosabb mozgoképekkel,

mint alloképekkel vagy szoveggel (viz kor-
forgasa a természetben).

Mozgokép beszurdasahoz haszndljuk a
Besziuras menii Mozgoképek és hangok
almeniijének Mozgdékép fajlbdél paran-
csat (Insert > Movies and Sounds >
Movie from File). Ezutdn keressitk meg
az allomédnyt a szamitdégépen vagy mas
helyen. '

A mozgokép beszurasa elétt a prog-
ram rdakérdez az inditas mddjara (hason-
Iéan, mint a hangoknal).

Ha az Automatikusan (Automtically)
elemre kattintunk, a mozgdkép oGnmaga-
tol fog indulni. Ha ilyenkor nincs mads
meédiahatds a didn, a mozgokép lejatszasa
a dia megjelenésekor indul. Ha mar taldl-
hatd mas hatds (példdaul animacid) a didan, |
a mozgoképet a program az adott hatds |
utan fogja lejatszani. A program auto-
matikusan hozzdad egy Sziinet (Pause)
hatdast a mozgoképekhez. Ez azt jelenti,
hogy ha diavetitéskor mozgdképre kat-
tintunk, az megall, és csak djabb kattin- |
tdsra indul ujra. A Kattintasra elemet
akkor vdlasszuk, ha azt szeretnénk, hogy
a program akkor jatssza le a mozgoképet,
amikor a dian lathaté mozgoéképkeretre
kattint.

A beszirt mozgékép allé képkocka-
ként jelenik meg a didn. A mozgoképfaj-
lok nem tényleges részei a bemutatonak,
csupdn csatolt fajlok.

Az inditasi bedllitas késSbb az Egyéni
animdcié munkaablakban wviltoztathato
meg. Mivel a mozgoképek az animadacios
hatasokhoz hasonlithatdk, lejitszdsi pa-
ramétereik nagyrészt itt allithaték be.

Tételezziik fel, hogy a mozgokép leg-
jobb része hét masodperccel annak eleje
utin kezdddik. Ilyenkor bedllithatjuk a
PowerPoint programot agy, hogy onnan
kezdje a lejatszéast. Ehhez jelenitsiik meg a
Egyéni animdcié munkaablakban a moz-
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goképhatas meniijét, majd kattintsunk
az Effektus bedllitdsai (Effect Option)
parancsra. A keresett bedllitaisok a Hatas
(Effect) lapon, a Lejdtszds inditdsa (Start
playing) panelen taldlhatdak.

Ha a didra kattintunk (példdul azért,
hogy a kovetkezt diara lépjen), a mozgo-
kép alapértelmezés szerint megdll (még
akkor is, ha hosszabb, mint a dia id&tar-
tama). Ha mondanivalénkat tobb dian
keresztiil szeretnénk aldtdmasztani moz-
goképpel, akkor szurjuk be a mozgoéképet,
majd adjuk meg, hogy azt hidny dia utdn
szeretnénk megallitani. Igy diavaltdsndl
a program folytatni fogja a mozgokép
lejatszasat. Az erre vonatkozo bedllitast
szintén a Hatds lapon, Ledllitas (Stop

playving) részen tudjulk elvégezni.

Towvabbi beillitasokat a Mozgbékép-
objektum szerkesztése (Edit Movie

Object) panelen taldlunk. Ehhez a pa-
nelhoz dgy jutunk el, ha jobb gombbal
a mozgoképkeretre kattintunk, majd a
helyi meniib8l kivdlasztjuk a parancsot.
A panelen a koévetkezd parancsokat ta-
laljuk:

Leallitdsig ismétli (Loop until
stopped) bedillitds hatdsdra a program
tjra ¢és djra lejdtssza a mozgoképet.

Visszaidll az elejére, ha lejatszotta
(Rewind movie when done ing) be-
allitds hatdsara a kezdé képkockara allitja
a mozgoképet annak lejitszasa utan.

Elrejtés a lejatszdsi idén kiviil (Hide
while not playing) utasitissal megaka-
dalyozhatjuk, hogy a mozgdkép megje-
lenjen a didn a lejatszdsi idén kiviil, majd
azt kdvetden el is tiintethetjiik. Ha ezt a
beallitast a teljes képernyés bedllitdassal
egyiitt hasznaljuk, ugy fog tiinni, mintha

34. kép. Az Effektus beillitisa panel, a mozgoképek esetében
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a mozgokeép egyaltalin nem is lenne rajta
a dian (bar a teljes képernyds lejitszas
eldtt felvillanhat a mozgdkép). Az el-
rejtéshez hasonld eredmény érhetd el a
mozgokép lehizasaval a didrdl. Ha elrejt-
jitk vagy lehiizzuk a didirél a mozgoké-
pet, a diavetitéskor az nem lesz elérhetd.
Gy6zddjink meg arrdl, hogy a mozgokép
automatikusan indul.

A Teljes képernydre nagyitds (Zoom
to full screen) bedllitis Ggy jatssza le a
mozgoképet, mintha annak sajat képer-
nydje lenne, tehdt a mozgoképet lejdtszo
dia nem latszik. Ha a mozgokép felbon-
tasa a nagyobb méret ellenére is kielégitd,
hasznidljuk ezt a lehetéséget. Ne feledjiik
el azonban, hogy ez az eredeti moz-
gokeépfidjl felbontasdtol fligg, ezért min-
dig ellendérizziik a bedllitas eredményét,
hogy visszavonhassuk a teljes képernyds
mdédot, ha a film képe elmosddott.

Az Informacidé (Information) részen
megtaldlhatéd a Teljes jatékidd (Total
playing time) ¢s a Fdjl (File) rész alatt a
mozgdkep elérési utvonala.

35. kép. A Mozgdképobjektum szerkesztése
parancs utin megjelend panel

FELADATOK

1. Sziharjunk be egy mozgdképet, amelynél
a hangot teljesen némitjuk és a lejitszas
sordn teljes képernydn mutatjuk be!




